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Chapter 1. Getting Started With V4.5 

About these notes 

These update notes are provided for existing users as a supplement to the 
existing Pulsonix Users Guide. These notes are to highlight new features in 
version 4.5 and to briefly describe their use. 

Each chapter is broken down into logical functional descriptions based on the 
application type, Schematic design, PCB design etc. 

Installing the New Version of Pulsonix 

It is recommended that you back-up all libraries, designs, technology files, 
profile files, reports and netlists before installing the latest version. Other than 
for any reason, this is good working practice, although you should have a backup 
already of all of this data!  

As with any other installation of Pulsonix, insert the CD and wait for a short 
time. The Autorun facility will start the installation procedure. Follow the on-
screen messages from the install wizard. You can install Pulsonix version 4.5 on 
top of your existing installation, you do not need to uninstall any old version 
first. 

New License 

Version 4.5 requires a new license that will be supplied to you with the update or 
by email.  

For existing users it is recommended that you simply click the No Change In 
Licensing check box on the licensing page of the Installation wizard. New 
licenses and changes to network licensing can be made after the installation 
using the License Manager. 

New System Files 

There are no new system files for version 4.5.  

New Additional Supplementary Files 

New Package libraries to support the 3D Viewer option are now supplied. 
Details of all additional files supplied are supplied in Appendix A at the end of 
this document. 
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Chapter 2. General Options 

Automatic inclusion of new Menu/Toolbar options 

Pulsonix will show new menu options and toolbar buttons without having to 
explicitly reset menus or toolbars. Any customisation that you might have setup 
will be retained. 

All new commands will be initialised as 'always show' options in the menu, but 
will revert to hidden 'infrequently used' items over time if not used. 

Print Enhancements 

The Print command now displays its own dialog, rather than the standard 
windows print dialog. This provides additional options to support Pulsonix 
design. It has the ability to print the Whole Design, and in a Schematic, All 
Pages, as an alternative to just printing the current screen view. 

 
Printing the current selection now prints using design colours rather than printing 
everything in the selection colour and fits the print around the entire selection 
rather than printing only the selected items visible in the current view. 

There is also the option to select All Colours Black and to Auto Rotate which 
will automatically select the best design orientation to fit the current paper 
orientation. 
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Windows Plot across multiple pages 

The CAM Plot option has been changed to allow the printing of pages across 
multiple sheets. 

The Windows Setup dialog now has an additional option to select Print across 
Multiple Sheets and optionally specify an Overlap value. This will allow a 
single large plot to be spread across several pages, e.g. print A2 across 4 pages of 
A4. It also now allows you to setup your own additional Print Margin, this is in 
addition to the printers own hardware margin. 

 
When a print will extend over multiple sheets of paper, the Plot Preview shows 
all pages and how the print will fit on them. The Number Of Pages to be used 
will also be shown as an addition to the plot Fits status. 
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Auto Weld Improvements 

Weld Spots 

Weld spots are displayed during move to show where a weld would be attempted 
if you were to finish at this position.  

 
They are drawn using a new highlight colour and are only displayed if the Show 
Weld Spots is enabled on the Options dialog and Interaction tab for Schematic 
designs and on the Move tab for PCB designs. 

 

Weld to middle of tracks 

There is a new option Allow Weld To Split Tracks on the Options dialog; on 
the Interaction tab for Schematic designs and on the Move tab for PCB designs. 
Check this to specify if tracks can be split by welding a moving pad (or track 
end) into the middle of them, or leave it unchecked to state pads can only be 
welded to free ends of tracks. 

 

Weld Now on the context menu 

This is an option on the context menu when moving components and is now 
available even if Auto Weld On Drop in the Options dialog is not enabled. This 
allows you to weld when you want to rather than every time a move is 
completed. 
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Report Maker Changes 

Reports On Libraries 

You can now run the Report Maker on all types of libraries (except 3D View). 

 
From the Library Manager page use the Report button. This dialog now offers 
the choice of running the standard report, or a new user report. The Report 
Maker button takes you to the Report Maker dialog to define a report for the 
library. 

When editing a Footprint, Schematic Symbol or Doc Symbol, from the Output 
menu, the Report dialog now has a User Reports checkbox. This enables you to 
run a library report on the single symbol you are editing.  

To handle the new library reporting mechanism, the Report Maker dialog now 
has three new Available for contexts: 

PCB Library - for running on Footprint and PCB Doc symbol libraries. 

SCM Library - for running on SCM symbol and Doc symbol libraries 

Parts Library - for running on a Parts library. 
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Save Inserted User Report 

There is a new command Save Inserted User Report that can be run using Run 
Command if an inserted report is selected in a design. It will create a format file 
that contains the commands from the inserted report. This is not on the menu but 
is useful for retrieving reports from old designs and for support purposes. 

New or changed LIST commands 

List of Libraries – this is only available when running a report on libraries. It 
forces you to report the items in each library in turn. If you don’t use this, and 
you are reporting with the lib manager dialog for [All Libraries] then the items 
will be processed in the order they appear in the library manager dialog. 

List of Symbols – this is available on the four symbol libraries, and for PCB and 
Schematic designs. It reports each symbol in the library or design in turn. Note: 
this is still required if editing a single symbol but it will be the only symbol 
reported. 

List of Parts – this has been extended for use on Parts libraries as well as on 
Schematic or PCB designs. 

List of Footprint Names – this is used within a List of Parts command to report 
all the footprint names used in the Part. 

List of Part Gates – this is a new command used within a List Of Parts 
command. Use it to report information on each gate in the Part. 

List of Part Pins – this is a new command used within a List of Part Gates 
command. Use it to report information for each pin on the gate. 

List of Attributes - available on all items that can have attributes, including 
Symbols, Parts, Part Pins Nets, Pins, etc. It lists each attribute on the item in turn. 
You can use the Attribute command for each item to report items name, value 
and (if present) position. 

List of Free Pads – this has been extended for use within List of Symbols as 
well as for a PCB design. This lists all the pins (or pads) in the symbol. 

List of Layers - this has been extended for use within List of Symbols for a 
footprint library. Lists all the layers used in the footprint. 

New command fields 

Library Name - use within a List of Libraries or within a List of Symbols to 
report the library file name. 

Library Path - use within a List of Libraries or within a List of Symbols to 
report the full location of the current library being reported.  

Is Associated Part - use on a Part to report if it is an associated part. 
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Part Group name - use on a Part to report the first Part name in the library 
group the Part is a member of. If the Part is not in a group, it reports its own 
name. 

Part Group Count - use on a Part to report how many Parts are in its library 
Part group. 

Date, Time and User - Three commands used at the top level (library or design) 
to report the current date and time and the name of the current user. 

Last Saved Date and Last Saved Time - Two commands used on a Part or 
Symbol to report the Date and Time of the last time the item was saved in a 
library. In other words, when used together these fields give the library version 
for the Part or symbol. 

Pin PCB Name and Pin SCM Name - Two commands used on a Part Pin, 
along with the existing commands Logic Name and Pin Name, to report the 
different names a Part pin has. PCB name is the footprint sequence number, and 
SCM name is the SCM symbol sequence number. 

Swap Group - use on a Part Gate or Part Pin to report the swap group name. 

Pin Network - use on a Part Pin to report its Pin Network name. 

Name Range Format - used to change the format of name ranges output for 
Parts and component groups. Adding this command displays an edit dialog that 
allows you to set the range separators to any string, and set the range start and 
end values to blank. So you can get "U1-9,U11" or "U[1-9], U11" for example. 

Load/Save Configuration Files 

It is now possible to save/load current program settings to/from a named 
configuration file. The Save and Load options are only available from the File 
menu with no designs open. The configuration file can be used to copy a 
complete configuration to any machine running Pulsonix. 
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Show Relative Coordinates 

When working in Relative mode, you can now force dialogs which show 
positional information to show everything relative to the relative origin. This 
option is set in the Options dialog and General tab under Relative Coordinates. 
If this option is left unchecked, the positional information will still be shown in 
Absolute coordinates even when you are working in relative mode. 

 

Recent Used File List now user definable 

The Options dialog and General tab now has an entry for you to define the 
number of files that will appear on the recent used file list. The list is limited to a 
maximum of 20 items. You will have to restart the program for the new value to 
take effect. 

 

Back Annotation 

There is now an option for Back Annotation to apply pin swaps by swapping 
the connections between the pins (like in PCB) instead of exchanging the pin 
names. There is also an option for doing this for only some swap groups, where 
you do not want the pin names to be moved in the Schematic for some Parts 
only. These options are defined in the Options dialog under the General tab. 

 
You have four options as follows: 

Never - No change to the existing way in which it works. 

Always - All pin swaps are applied by swapping connections. 

Positive - All pin swaps in swap groups that have a positive id will swap 
connections. 

Negative - All pin swaps in swap groups that have a negative id will swap 
connections. 

Note: Gate Swaps are not affected and will continue to exchange gate id and pin 
numbers. 
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Auto-Hide delay 

There is now an option to set the delay period before an auto-hide window slides 
out of view. This can be found on the Options tab of the Customise dialog. A 
delay of between 0.1 and 60 seconds may be specified. By default, this is set to 
0.7 seconds. 

 

Zoom Factor Control 

You can control the zoom factor for the zoom commands (mouse wheel and 
shortcut keys). This is available on the Options dialog and General tab. 
Changing the slider will make the zoom factor finer or coarser as preferred. 

 

New Command in Move 

There is a new command Reset Delta Coords available during Move. Use this 
to reset the dx and dy on the status bar to 0,0 whilst moving an item. This should 
be added to a shortcut key to be used, it is not available on the context menu. Use 
this to position an item relative to a known position, or another item. 

Move Option 

This is a new option in the Options dialog, under Move options for PCB and 
Interaction options for Schematics, called Rotate/Mirror About Centre. If 
checked it works like it did in previous versions and rotates or mirrors about a 
gridded point at the selection centre. If unchecked, rotate and mirror work like 
they do in Select mode, about the picked item origin. 
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Select Improvement 

If you drag the left mouse button in select mode whilst holding down the Alt 
key, it will now always go into Frame Select whilst dragging. This enables you 
to frame select more easily in tight areas. This is an option on the Options dialog 
and Interaction tab. 

 

Colour Files Bar 

An additional dockable window showing a list of available colour files has been 
added. Simply clicking on a colour file name will apply it to the current design. 
The list of files will automatically update if new colour files are saved or the 
folder list changed. There is also a context menu option Refresh List to 
explicitly update the list (if, for example, colour files have been deleted via the 
Windows Explorer). 

   



18   Pulsonix V4.5 Update 

New Cross-Probe Option 

A new check box on the Options dialog, Interaction tab for Probe Any Design 
has been added. With this checked, Cross Probe will probe to any open design. 
With it unchecked, the option will try and probe to the same named design of the 
opposite type, i.e. PCB to SCM or SCM to PCB. 

 

Font Size in HTML Help 

It is now possible to select an alternative font size when using the Pulsonix Help 
Viewer. This is available by clicking the Font button on the toolbar. 

 

World View 

The world view will now show the currently highlighted net. (Note: this is a net 
that has been located via the Find Bar and is different to a marked net). For this 
to operate, you must have Select Found Item switched off in the context menu 
for the Find Bar. 

 



 Pulsonix V4.5 Update   19 

For PCB, the world view now also includes component outlines and consistently 
excludes vias. 

The world View now includes a context menu option to show Board Extents as          
alternative to the Design Extents or Working Area. In SCM, this works the same 
as Design Extents. This is useful if you are using a drawing profile in your PCB 
design but wish the World View to focus on the board outline. 

 

Changes to Find Browser 

Drill Sizes 

Find has a new category Drill Size. Selecting this will list the drill sizes in the 
design. Clicking on a drill size finds the first item that has this drill size (pad, 
mounting hole or via). Use the Find Next button to find next item with this drill 
size.  

Note: The matching of an item's drill diameter to the chosen drill size will follow 
the same rules as in the drill table, i.e. it will use tolerances. This means that if a 
drill table says it has 3 items for a size, the find bar will find the 3 items. 
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Filter by Layer 

You can now filter by Layer or Layer Span for some categories. When 
available, a Layer checkbox will appear at the bottom of the filter controls in the 
bar. Click on the checkbox to use the filter and select the layer that items must 
have to be found. The item must have this layer to be found. For example, if the 
layer chosen is Bottom Electrical and the item is a through-hole pad, it will not 
be found. 

Note: Via and Drill Size categories present a Layer Span list if you have more 
than one Span. 

 

Filter by Attribute changes 

Filtering by attribute has changed to include two new operations in the Is combo 
list. These are exists but not matching and exists but not equal. These differ 
from the not matching and not equal operations in that the item must have the 
attribute to be found. 
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New Find option in Options dialog 

There is a new option on the Find page of the Options dialog - Allow Find 
Under Sliding Bar. This allows find items to be under the Find bar when it is in 
Auto Hide mode and not pinned.  If unchecked, the item under the bar will be 
moved to the centre of the view. This option only has any effect if the option 
Centre View On Item is unchecked. 

 

Merge Shapes 

Merge Existing Shapes  

You can merge a set of selected shapes using the Merge Shapes command (also 
see Insert Merge below). 

  
Add two shapes to the design. 

Select both shapes and select  
Merge Shapes from the context menu. 

The two shapes are 
merged as one. 
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Add Cutout 

Adding a cutout now removes the cutout shape from the outline, if they intersect. 

 

 

Once the shape is drawn, select Insert 
Cutout. Select the shape. Draw the cutout 
starting outside the shape. Draw ‘across’ the 
initial shape and finish. 

The resulting shape is now 
minus the shape ‘cutout’. 

Insert Merge 

A new set of commands allow you to add a new shape to be merged with an 
existing shape. The function is similar to Add Cutout, except the shape is added 
rather than removed. 

Text Callouts 

There is a new composite design item, Text Callout, in both PCB and Schematic 
designs used for documenting points of interest. 

 
Text callouts consist of a text item, a shape around the text (the text box), a line 
from the text to the location of interest (the pointer), and a shape at the end of the 
line (the pointer end). These items are invisibly grouped so that it acts as one 
dynamic item in the design.  
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Using Text Callouts 

From the Insert menu, use Insert Text Callout, select the pointer end position, 
you will be presented with a dialog to supply the text and layer (in PCB design). 
The layer can only be a non-electrical layer. The callout is displayed on the 
screen and you can place the text item at the required position.  

The defaults for the styles, layer and appearance of new callouts are defined in 
the Design Settings dialog on the Setup menu. You can override this by 
selecting a Text Callout or Free Text item in the design before using the Insert 
Text Callout option. 

 
Once added, the text callout can be moved for repositioning by selecting the 
outer edge and dragging it. The text box alone can be repositioned by selecting 
just the text. You can also drag the Pointer End to a different position. 

You can change the text callout appearance by selecting it and using the 
Properties dialog from the context menu. You can change the Appearance of 
each of the entities. 
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Different styles of text callouts can be achieved by changing the Properties of 
these items. 

 

Part Editor Improvements 

When editing Parts which use grid based components such as BGA footprints, 
this dialog helps you to assign pin names automatically. 

 
The dialog presented allows you to define how the pads are named. 

 
Pin Order 

These controls allow you to choose the direction in which the pins will be 
named. The settings you need to choose here will depend on the order in which 
you have numbered the pins in your PCB symbol. Choose which corner you 
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want to start from, and the direction to go from that corner. With the selection 
shown above, the bottom left pin would be A1, the pin to its immediate right 
would be A2, and so on across the bottom row, then the leftmost pin of row 2 
would be B2. 

Spacing 

These controls allow you to specify the step between the pads that constitute 
each row and column of your PCB symbol. The initial settings will be 
automatically determined by examining the arrangement of pads on your symbol, 
but depending on the order in which the pads were created you may need to 
adjust these values. 

Naming 

This control allows you to specify particular characters that will be skipped over 
when creating the pin names. 

The results 

Once you have set up the dialog controls and clicked OK, the pin names will be 
automatically created and displayed in the various pages and views of the parts 
editor. 

The first pin will be named A1, the second A2, and so on until the end of the row 
or column is reached. The next row or column will start with B1, and so on until 
all the pins are named.  

Where there is a break in the sequence of pins, the pin names for the missing 
pins are skipped and resume with the pin name appropriate to the row/column 
that the pins re-commence. 

Part Editor Attributes 

Swap Rows/Columns 

In the Part editor you can swap rows/columns in the attribute view using the 
Swap Rows/Columns option from the context menu, this makes it easier to see 
Attribute Values when you have a lot of attributes. 

Take this example of a number of attributes for this Part: 

 
Select the Swap Rows/Columns option: 
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The Part view now looks like this: 

 

Changes to Hyperlinks 

Hyperlink Attributes 

Any attribute can now be a hyperlink; this means that you can have more than 
one hyperlink per item. To set attribute as being a hyperlink, check it’s checkbox 
in the Attributes tab of the Technology dialog. 

The <Hyperlink> attribute is now redundant, but is still present for items which 
already use it. 

 

Execute Hyperlink 

You can now execute any text item (using the shortcut for Execute Hyperlink). 
For example, plain text with the word Excel will run the Microsoft Excel 
spreadsheet program. If the text string includes a path and file extension, such as 
C:\temp\bob.xls it will run the spreadsheet bob in Excel (or whatever program is 
associated with the .xls extension). 

If Pulsonix thinks text is a hyperlink it puts the Execute Hyperlink command on 
the context menu as well and will also activate the link on double-clicking. 
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When executing hyperlinks that don’t contain a specific path, for example the 
text name Job99.pcb, the current directory is set by the relative path of the 
design that the hyperlink is executed from. If job99.pcb didn’t exist in the same 
folder as the current design, the hyperlink wouldn’t run. 

Default Part Attributes 

In the Part editor, you can set a flag on an attribute to make it a default attribute 
for new Parts. This status would be saved in the Part Technology file for use 
when you create a new Part. These unsatisfied attribute names are added to the 
new Part ready for you to add a value to it. 

 

 
When added, in this example, the Mfr and Category attribute names are now 
added ready to have values assigned to them. 

Attributes can be back annotated 

You can now mark an attribute as Back Annotated, the values for Design, 
Components, Nets and Pads are then passed back during back annotation. These 
are marked in the Technology on the Attributes page. Effectively, this allows 
attribute values to be edited in the PCB and back annotated to the master 
schematic design. 
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Change Style Apply to Whole Net 

A new option was introduced late in version 4.0 and has now been incorporated 
into version 4.5. When changing a Track Style, there is a check box to allow you 
to Apply To Whole Net as an option when making the style change. 
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Chapter 3. Schematic Options 

New ERC Checks 

New Electrical Rules Checks have been introduced to version 4.5. 

 

Bridged 2-Pin Components 

Check this box to verify that every two pin component has its pins on different 
nets. 

Coincident Items On Different Nets 

Use this to check that items that are not on the same net do not lie on top of each 
other. It will check every connection and bus corner, and every pin. Connections 
on different nets are allowed to cross each other as long as a corner on one does 
not lie on the other. Pins are checked against all connection and bus segments 
and against all other pins. 
 
Note: On all but small designs it is a good idea to have the Fast Locate option 
switched on in the Display Options dialog. 
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Split Nets 

Use this to add an error marker on all nets that are split into separated subnets. 
These may be valid, but this allows you to quickly check if a net has been split 
by error.  
Use the If Not Linked By Doc Symbol check box to not mark a subnet as being 
split if it contains a documentation symbol of any type. It assumes that the 
documentation symbol is an off page reference or signal reference. 

Pins Not On A Net 

Use this to add a marker on all pins that are unused and have not been added to a 
net. It will also add markers on a component if its ungated pins are not on a net. 
Note: Pins with pin type No Connect will not be marked. 

Net Pins With No Connection 

It is possible to select a pin and add it to a net without adding a connection to it. 
These are not obvious in the design and can now be found using this check box. 
Use this along with Pins Not On A Net to mark all pins that do not have a 
connection attached in the design. 

Unmatched Page Link Check 

A new check Unmatched Page Link has been added. This creates a UP error 
marker on net nodes that have a page link that is not matched on the page it links 
to. For example, if net "A1" on page "Page1" has a page link to "Page2", then it 
is an error if the net "A1" on page "Page2" does not have a link back to page 
"Page1". 

Additional Error Codes 

Another ERC change for 4.5 is that error codes have been changed to all be 
relevant 2 letter codes. Most have changed. 

Split Net 

The Split Nets option is now available in schematic designs. The only difference 
to PCB is that if pins would become isolated (i.e. they are the only item on the 
net) after the split then you will be warned that these pads will be removed from 
the net. 
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Split Net highlights nets now, rather than marking them. This has the advantage 
of seeing invisible items on the net. 

In schematic, dragging a 2 pin component and dropping onto an existing 
connection will now display the Split Net dialog. This allows you to choose 
which net retains the original name and to be able to supply a net name for the 
split half. 

 
If you select a connection or track and it does not split the net, you now get the 
chance to OK the deletion question so that as a minimum it deletes the 
connection. 

Delete 

You now have the two new options for Delete on the Options dialog and 
Interaction tab. 

Split Unlabelled Subnets. If this is checked, after using Delete, any new subnets 
that have been created and are unlabelled will be split from their old net to form 
new unnamed nets. A Warning will be given allowing you to cancel the delete if 
required. Leave the option unchecked to leave the subnets on the same net, (this 
is how it worked in previous versions). 
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Note: An unlabelled subnet is one that does not display its net name and does not 
have a signal reference documentation symbol with a predefined net type or 
name. This is as defined in the ERC check. 

Highlight New Nets - Check this to highlight any new nets created by the 
deletion.  

Disconnect Con End / Remove From Net 

When using the Disconnect Connection End and Remove From Net option, 
these options will now warn you if you separate a user named net into subnets. 
Default nets will be automatically split into new nets. 

 

Next/Previous Commands for Insert Doc Symbols 

You can now use the commands found on the context menu Next Symbol and 
Previous Symbol (and the shortcut key commands) to cycle through next and 
previous Doc Symbols when using the Insert Doc Symbol, Insert Sig Ref and 
Insert Page Link options. This saves you having to go back to the Insert Doc 
Symbol dialog to select the next item in the list. The Next/Previous Symbol 
command will cycle through the Doc Symbol list and will use filtered symbols if 
a filter has been applied. 
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Chapter 4. PCB Options 

Enhanced PCB Footprint Wizard 

The existing footprint wizard has been significantly enhanced to give you more 
pre-defined shapes to select from and on the Pads page it now shows the actual 
dimensions. The dimensions now more closely follow the dimension formats 
used in the manufacturers datasheets. 

 

 
The Preview of the footprint being created has been moved to the right side of 
the dialog and has been significantly increased in size to make the creation of 
fine pitch devices much easier. 
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Changes to the Library Manager 

There is a new tab (3D View) on the Library Manager dialog to support the new 
3D Viewer option. The editing of 3D packages and their use is discussed below. 
Package libraries are saved with the .pkg file extension. 

The Preview window displays the 3D package view and the ‘flat’ Footprint 
library view. 

 
The Details tab switches to a detail summary of the package. It shows the 
Footprints defined for the package, the package style and the list of other 
Footprints also using this definition. 
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3D Viewer 

The 3D viewer allows the ‘flat’ view of the PCB to be visualised as it would be 
when populated with components after assembly. A new menu option 3D View 
on the View menu in the PCB editor is used to display the current design into the 
viewer. The appearance of components in the 3D view is controlled using a new 
library type of 3D packages. These can be edited as new footprints are added to 
your library. 

 

Printing 

Once in the 3D View, you can use the Print option from the File menu. 

Zoom in the 3D View 

As well as the normal zoom controls on the View menu, the mouse wheel works 
in the same way in the 3D View as it does in the design editor. If you single-
click the wheel, a pan is executed. If you hold the wheel down you can pan 
around the 3D view. 

If you hold the right-mouse button down the 3D View picture will spin 
continuously. 

3D Settings 

The 3D Settings dialog is available on the Setup menu. The three tabs within it 
allow you to define how the 3D view will look. 

The Layers tab will enable you to switch on and off the design layers within the 
view. 
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The Colours tab allows you to setup preferred colours for the 3D view. 

  
The Settings tab is used to define view parameters such as the thickness of the 
board in the 3D view. 
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Each of the entries for Sizes defines a thickness that can be created and viewed. 
You may change the Gap thickness to show internal layers more clearly, perhaps 
to show the internal via stacks. 

 

Defining the 3D Packages 

From the Library Manager, the 3D View tab enables packages to be edited. 

In order to view components in the 3D viewer, you must define the package 
‘shape’ in the library. Use the new 3D View tab in the Library Manager to 
define package libraries. 

 
The package libraries have the file extension .pkg. The contents of the package 
libraries have definitions which relate to a footprint or groups of footprints, for 
example DIP*.  

 

Package Overview 

3D Packages define how footprints are represented in 3D View images of your 
PCB designs. Each 3D Package has a 'style' (DIL, Quad, Axial, and so on), and 
various settings that control how the 3D image is generated. It also has one or 
more names that specify which footprints the 3D Package applies to, allowing 
one package to be used to generate the 3D image for many PCB footprints. 
These names can be specific footprint names, or they can include 'wildcards' to 
match multiple footprint names.  

To generate the 3D view of the actual components on your PCB design, the set 
of package libraries is scanned to find the first package that matches each of the 
footprints used in the design. Because each package can have a basic name and a 
set of 'aliases' both of which can include wildcards, it is possible to create a few 
packages that can auto-generate the 3D view for many PCB symbols. 
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If no package is found, a default representation of the footprint is generated 
using type ‘Shape’ with the components colour from the Settings dialog. 

3D View Dialog 

The 3D View tab gives a Preview of the 3D package and 'normal' view of a 
corresponding footprint for the selected item. Even in this view, the picture can 
be rotated in its 3D axis. The Details summary shows the Footprint, shape and 
alias for the selected package. The footprint that is used for this dialog will be 
the first one found that matches the rules defined by the selected package. 

 

Edit 3D Package 

This Edit button is used to edit the selected 3D package. Fields on the dialog 
allow you to specify which PCB footprints this package would be used for, and 
the style and other properties of the package. Only one package at a time can be 
edited 

Using the ‘Edit 3D Package’ dialog 

Choose the package you wish to edit, and click the Edit button. The dialog is 
divided into several sections, each of which is described below. Depending on 
the type of package, and other factors like the number of pins, some sections or 
controls may not be available or appropriate, or may not have any effect on the 
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resulting picture. The best way to see the effects is to try them out and see how 
the Preview picture changes. 

 
Package Style: The main control in this section, which specifies the general type 
of the package. Available styles are: 

Axial Generally two-pin through-hole components like 
resistors and diodes. 

 

Bead Rounded components like LEDS use this style. 

 

Box Rectangular components where the box is taken 
from the overall size of the component. 

 

Can Vertical cylindrical components such as large 
capacitors. 

 

Chip Surface-mount chip-type components such as 
chip resistors and capacitors. 

 

DIL Dual-in-line components such as DILs, SOICs. 
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Quad Components (generally surface mount) with pins 
on all four sides. 

 

Shape 
General components where the 3D body shape is 
derived from the 'best fit' shape in the PCB 
footprint.  

 

Height: the overall height of the component body. In the 3D PCB picture this 
value is a default and only used if the component does not have a height defined. 

Inside: for some types, this specifies the amount by which the body should be 
undersized. 

Standoff: the distance between the board surface and the underside of the 
component body. 

Body Colour: the colour of the component body. 

Top Closed/Coloured/Colour: Some packages styles allow the top of the body 
to be open or closed, and/or set to a different colour to the rest of the body. 

Pins 

This section specifies how the pins should look. 

 
Style: Type of pin. Some of the pin styles are sized and positioned to fit 
particular styles of package. For example, J-Lead, Gull-wing and DIL pins will 
only work for package styles such as DIL and Quad where the pins are around 
the edge of the component. 

Colour: Pin colour 

Length: Overall length of pin. This does not have any effect for some types such 
as J-Lead and DIL which measure the pin length automatically from the midline 
of the component body. 

Offset: Allows the pin to be offset up or down the component. 
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Mounting Holes/Pins 

Same as pins, but for mounting holes on the footprint. 

 

Applies To Footprints 

This section specifies the footprint names to which this package will apply. The 
first name is the name by which the package will be listed in the Libraries dialog. 
The other list shows additional names to which this package will match. Any of 
these names may contain wildcards, as shown in the example below.  

 

Preview 

This section shows a preview of the 3D package you are editing, as long as an 
appropriate footprint can be located in the available libraries. Just below the 
preview is shown the name of the footprint that is being used.  

You can see the effect of changing any of the controls on the dialog straight 
away. The picture can be rotated in any direction (in the same way as for the 
main 3D view itself) by moving the cursor into the preview window, pressing 
and holding down the left mouse button and then moving the mouse. Buttons are 
also provided to allow you to zoom In and Out of the preview picture. 
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Changes to Define Pad Shape 

Multiple Shapes During Editing 

You can now have more than one shape during editing. This is subsequently 
restricted to only allowing a single shape when saving the pad shape. A warning 
message will be given if the pad contains more than one shape. 

DXF Import 

Using the File menu and Import Design Data option, you can import DXF into 
a pad shape. The same rules apply as above when saving multiple shapes. 

Layer Stack Preview 

On the Technology dialog, there is a new View Layers button on the Layers 
and Layer Span pages. This gives a simple view of the layer stack and any layer 
spans defined for through-hole and blind and buried via stacks. 

 
All layers are displayed with electrical layers labels shown in a more prominent 
colour for easy identification. 

Intelligent Gerber Import 

The Intelligent Gerber Import option allows you to rebuild a design by 
importing existing Gerber files, NC Drill files and a bill of materials (BOM). 
This differs from the existing Gerber Import option as the standard Gerber 
Importer is primarily only a viewer. 
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Once the files have been imported you should have a design with Free Pads 
connected by tracks. The Component Bin will contain any components defined 
in the Bill of Materials. Use the Generate Component tool to convert free pads 
and silkscreen shapes into components and symbols, and the Free Pad to Via 
tool to create vias. 

 To start importing and rebuilding Gerber files 

1. From the File menu, select the Intelligent Gerber Import option. 

2. You do not need to have the PCB design editor running; you can select this 
option from the File menu with no designs open. 

 
3. After selecting this option, a dialog is displayed: 

 
4. Technology files are used during the import for layer selection and to pre-

assign Spacings, Styles etc. from an existing file. 

5. The Add button is used to select the files for import. The Edit button is used 
after the list has been populated and on selection of one of the files in the 
Input Files list. 

6. Click the Add button. The Open dialog is displayed. 
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7. From the Open dialog you can select an individual file or multiple files 

using Ctrl, Shift and frame select. 

8. Click the Open button to load the files ready for import. 

9. For input files, as each file is being loaded, a settings dialog is displayed for 
the Gerber, NC Drill and bill of materials file types.  

10. From these dialogs you can choose how the file will be imported. 

 
11. This dialog allows you to confirm the format of a Gerber file prior to it 

being imported. A number of Gerber files can be imported at the same time 
to rebuild a complete design. 
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12. A Gerber file consists of line draws and shape flashes usually of specified 
sizes. If may also contain filled shapes. There is no electrical, connectivity, 
text or other information in the file. Typically for our purposes, flashes 
represent pads, and line draws represent tracks. You must decide which 
layer the flashes and draws are placed on. The program will attempt to 
rebuild the draws into shapes, and for tracks will create nets joining the 
pads. At this stage, all pads will be free pads which can subsequently be 
converted to Component Pads and Vias.  

13. Other than changing the Track Layer, when importing multiple files, the 
Gerber File Settings option will select the best options for you. 

14. The NC Drill Setup dialog allows you to confirm the format of an NC Drill 
file prior to it being imported. A drill file should be imported along with 
number of Gerber files, to rebuild a complete design. 

 
15. The Bill Of Materials dialog allows you to confirm the format of a Bill of 

Materials (Parts List) file prior to it being imported.  

 
16. A Bill of Materials file should contain lines of delimited fields (often a 

comma separated file) containing a list of the components used in the design 
(one entry per line). Using this dialog, you can specify which fields 
represent the values needed. As the file is read, components are added to the 
Component Bin. If the components are defined in the library, they can be 
added from there, giving a complete definition. Otherwise, the components 
will be incomplete (no silkscreen shapes, no pins, etc). You can 
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subsequently complete their definition from shapes and pads in the design 
(usually imported from Gerber).  

17. Once all the files have been selected for input, they appear in the list. 

18. The Delete button can be used to remove selected files. 

 
19. Once you have selected the data files, press OK to start the import process. 

Once the files have been imported you should have a design with Free Pads 
connected by tracks. 

20. At this point, your design will contain tracks (with default net names) 
connected to free pads and free pads making up patterns which will 
represent components. It may also contain shapes which represent the 
silkscreen outlines on non-electrical layers. 

21. The Component Bin will contain any components defined in the Bill of 
Materials. These components can be moved out of the bin and placed in the 
design. When placed over existing pads and shapes, they will auto weld 
themselves back in replacing what is already there. 

Generate Component 

You can replace or recreate a component from its constituent free pads and doc 
shapes. This is particularly useful when used in conjunction with the Intelligent 
Gerber Import option. 

The process for using this is to first select pads in the design using Frame Select 
or Ctrl/Shift select. Don’t worry if tracks are selected as they will be ignored. 
After clicking the right mouse button, select the Generate Component option 
from the shortcut menu. 
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 To rebuild Components 

1. Use the Generate Component tool to convert free pads and silkscreen 
shapes into components and symbols (use the Free Pad to Via tool to create 
vias, see below). 

 
2. This will display the Generate Component dialog: 

 
3. You need to specify what the selected items will be replaced by. There are a 

number of scenarios.  

 The component is already defined in the current design. 
> Select the Part name from the dropdown list. Only part with the same 
number of pins as you had selected are shown. The program will fill in the 
remaining fields and estimate the position and rotation from the selected 
pads.  

 The component is already in the current design, but is undefined (such as 
when created using Intelligent Gerber Import). 
> Select the Symbol name from the dropdown list. The program will convert 
the selected documentation shapes into a symbol outline. All other instances 
using this component will share this definition.  
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 The component is not defined in the current design and you wish to define it 
using the selected items.  
> Type the new Part name into the Part field. The program will convert the 
selected documentation shapes into a symbol outline.  

 The component exists in a library but is not in the current design. 
> Use the Find in Library button to find the component. The program will 
load the component into the current design; it will also estimate the position 
and rotation from the selected pads.  

 The component instance already exists in the Component Bin and you wish 
to replace the selected items with it. 
> Select the Reference Name from the list, the program will estimate the 
position and rotation and place the component. Alternatively, do not use the 
Generate Component option. Just drag the component instance and let 
Auto Weld connect the component.  

Free Pad to Via 

Select a pad and use the option from the context menu or, with nothing selected, 
run the command Free Pad to Via and from the context menu use the Apply To 
All option. Only free pads on the nets will be converted. 

Layer Toggle 

In version 4.5 a new mechanism has been provided for 16 new 'Toggle Layer n' 
commands that may be used to toggle the display of particular layers on/off. By 
default, these commands are not present on any menu but are available via the 
Customise dialog, for assigning to shortcut keys (or toolbars/menus). 

  
By default, a particular Toggle Layer command will toggle the correspond layer 
in the defined layer order. For example, assigning the shortcut key Alt+3 to the 
command Toggle Layer 3 via the Keyboard page of the Customise dialog, will 
mean that the third layer, as defined in the Layers page of the Technology 
dialog, will be toggled on or off whenever the Alt+3 key is pressed. The defined 
layer order is also shown in the Layers Bar if displayed.  
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It is possible however, to change the layer or layers to which a particular Toggle 
Layer command applies. Selecting Set Toggle Layers from the Layers Bar 
right click shortcut menu will display the Layer Toggle Setup dialog.  

The Layer Toggle Setup dialog 

This dialog shows all the available Toggle Layer commands along side a slot for 
specifying the layer to which each should apply.  

 
Using Set Toggle Layers from the Context menu in the Layers Bar shows the 
Layer Toggle Setup dialog, Toggle Layer commands may be assigned to chosen 
layers by name or by characteristics. All Toggle Layer definitions will be saved 
and restored whenever the application is restarted and are independent of any 
particular PCB design. 

An empty slot implies the default association with corresponding layer in the 
layer order. Typing a specific layer name next to a particular Toggle Layer 
command will cause it to apply to that layer. Continuing the example from 
earlier, if "Top Electrical" is entered next to the Toggle Layer command 3 then 
pressing Alt+3 now will toggle the "Top Electrical" layer on or off.  

All Toggle Layer definitions will be saved and restored whenever the 
application is restarted and are independent of any particular PCB design.  

If layer names vary between designs it may be preferable to associate layers by 
characteristics rather than their explicit names. The format of recognised layer 
characteristics is: 

    <Layer Class> <Side> {<Index>} 

where <Index> is optional. 

So "Electrical Top" would always match the electrical layer on the top side 
regardless of whether it was named "Top", "Top Elec" or anything else, "Paste 
Mask Bottom" would always match the bottom paste mask layer if defined. 
Continuing again with the earlier example, if "Electrical Inner 2" is entered next 
to Toggle Layer 3, then pressing Alt+3 now will toggle the second inner 
electrical layer in a PCB design regardless of what it is called.  

A Toggle Layer command associated with a un-recognised layer will have no 
effect.  

When a Toggle Layer command has been associated with a particular layer it's 
command name will change to appear as a command for toggling that layer 
rather than the default 'Toggle Layer n' command. In the example given earlier 
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the command will appear as "Toggle Layer: Electrical Inner 2" rather than 
"Toggle Layer 3". 

How to toggle multiple layers simultaneously 

It is possible to specify more than one layer against a single Toggle Layer 
command so that a 'set' of layers are toggled when the command is used. Within 
the Toggle Layer entry, each layer definition should be separated by a comma. 
For example, Toggle Layer 3 could be extended to be "Electrical Inner, 
Electrical Inner 2" which would toggle both inner electrical layers 
simultaneously.  

Switching Layers on and off simultaneously 

Where multiple layers are specified for a single Toggle Layer command, it is 
possible to simultaneously turn some of them on and some of them off thus 
allowing 'sets' of layers to be visibly switched. To achieve this, any layer to be 
switched the opposite way to the first layer specified should be followed by the 
word "off". For example, defining Toggle Layer 3 as "Electrical Top, Electrical 
Bottom, Electrical Inner off, Electrical Inner 2 off" will allow the top and bottom 
electrical layers to be made visible and at the same time, the two inner electrical 
layers to be made invisible. Using the Toggle Layer 3 command again will have 
the opposite effect. 

Swap Routed Gates & Pins 

Two new options exist when attempting to swap routed gates and pins. 

The Swap Routed Pins option exists on the shortcut menu when using Swap 
Gates or Swap Pins. Check it to allow selecting of pins that have routes attached. 
The track segment attached to the pad will be unrouted prior to swapping. 

 
The Attributes Must Match option command exists on the shortcut menu when 
using Swap Gates. Check it to only swap gates between Components that have 
the same attributes (this is how version 4.0 worked), or leave unchecked to 
ignore attributes. 
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Edit Track Reverse Edit Direction 

A new command, Reverse Edit Direction is now available when editing an 
unrouted connection to add a track. Selecting it will keep any track segments 
already added, throw away the dynamic segments and then edit the connection 
from the other ‘end’.  If the item at the other end of the connection is off the 
screen, the view will be panned to position it in the centre of the display. 

The command is on the sub-menu under Change Segments > and Reverse Edit 
Direction 

 

  

Start editing the connection this way. And after the Reverse Edit Direction 
command, the edit direction has been 
changed to the other end. 

Square Ended Tracks 

To further support the creation of RF designs, tracks can have square ends 
instead of rounded ends.  

 
This is defined on a Net Class basis in the Technology dialog. For each net class 
that requires this track style, edit the Net Class and on the Routing page, select 
the Square Ended Track option. The square ends are checked correctly by 
DRC. 
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RF Mitres using Chamfered Track Corners 

Another additional feature to support RF designs is the creation of RF Mitres. 
Track corners can be chamfered (45 degree outside corner and 90 degree inside 
corner).  

 
This is defined on a Net Class basis in the Technology dialog. For each net class 
that requires this track style, edit the Net Class and on the Routing page, select 
the Chamfered Track Corners option. The size of the chamfer can be changed 
using the proportion parameter on the dialog. 
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Unroute Tracks Change 

The Unroute Track Segments and Unroute Track Path options are now 
available on the context menu when items are selected that have track segments 
attached to them, for example, a component, pad or copper items. The first 
option will unroute all track segments attached to the selected item(s), and the 
second option will unroute all track paths attached to the selected item(s). 

 

Track Hugging Improvement 

Track hugging now allows you to hug at distances greater than the minimum 
design rule gap. There is an option in the Options dialog on the Edit Track tab 
called Track Hugging Always Uses Minimum Gap. You can switch this off to 
maintain the gap from the end of the dynamic track to the shape to be hugged.  
This switch can also be changed from the shortcut menu whilst in the Edit 
Track stage where you pick the shape or track to hug. Note: The cursor changes 
whilst in this stage to show a shape with a question mark on it indicating you 
have to pick a shape. 

 

Track Hugging 

By picking the ‘host’ track, an equi-space distance will be applied rather than 
maintaining the minimum track to track distance. 



54   Pulsonix V4.5 Update 

 
Once the host track is hugged, it follows an exact distance. This could be used 
where an exact parallel track path(s) is required. 

 

Alternative Method 

The original alternative method is still available for use. Selecting the ‘host’ 
track in close proximity will enable the hugging mode using the minimum track 
to track spacing rule. 

 

Drill Names 

You can now sort the drills in the Drill Sizes dialog (in the Technology file and 
CAM Plot option) by clicking on the column header.  

 
The Rename All button will regenerate the names of the drills in the order they 
appear in the dialog. In particular you can sort the drill by the used state, so 
consecutively naming the used drills. 
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DRC Changes 

Online DRC Changes 

The Online DRC checking done 'on drop' now includes Component checking 
against areas. 

 

Online DRC Change in Options 

A new switch, Check Poured Copper in the Options dialog on the Online 
DRC page have been added in V4.0 build 2569 to allow you to force online 
DRC checking to ignore poured copper. 

 
Use this when adding tracks that will be routed into a poured copper shape. This 
will stop the continuous track to copper errors being displayed. Re-pour the 
copper after the track has been added to clear the copper around the track. 

Change to Component to Component Error Markers 

Following a DRC check, Cm-Cm errors now have their start/end positions 
shown from the centre of the components involved, which then causes a tie-line 
to be drawn between the component centres. 
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Design Tooltips for Errors now show the "annotation" (e.g. C2-X3 for Cm-Cm 
errors) and the spacing and gap. 

 

Check between item on same net 

A new check had been added to the Design Rules Check. This allows the same 
net track to pad check. This means that it is an error for pads, tracks or vias on 
the same net to overlap. Only tracks which connect directly to a pad or via are 
allowed, and there should be no track corners within the pad shape. 

A check box is available in the Technology dialog and Spacing tab for the Net 
Class rule level. 

A check box is available to Check between item on same net. 
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New Track to Star point checks 

Track to star point checks now allows corners within the pad. 

For example, this type of track edit: 

 
This check doesn’t allow re-entrant tracks within the pad also. 

         

Router Dialog Change 

The Router dialog now has a View Report on Completion checkbox. Check this 
so that the report is now displayed when the router has finished. 

 

Moving Copper Terminals 

You can now move a copper terminal that has a track attached to it (copper 
terminals are used to connect a track to a Template for example). The movement 
is restricted to within the copper or template shape or to the outline if shape is 
not filled or closed. 

Copper terminals cannot be selected so this move can only be performed by 
clicking on and dragging the copper terminal in one action. 

Thermal Pad Connection Rules 

In The Technology dialog, DFM/DFT rules, you can now define the default 
Thermal Pad connection at the design level or the Net Class level as well as an 
individual item type. 
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The choice of Isolated, Not Isolated and Thermal Pad are available. Individual 
pads and ‘classes’ of pads can still be changed using the Additional Rules 
dialog. 

  

Changes to Add Via 

When adding vias and using Change Nets, merge nets is never performed (the 
vias are moved from their current net to the new net).  

Change to Protected Vias on Edit Track/Breakouts 

A new check box in the Options dialog under Edit Track and Edit Breakout 
tabs now allow End On Via - Adds Protected Via. Check this to protect vias 
added against automatic deletion and layer span changes. 

 

High Speed Option – Changes to Differential Pair Routing 

Improved Diff Pair Editing 

It is now easier to add differential pair definitions in the Technology dialog. The 
two connections that define the differential pair are selected (using Shift and Ctrl 
keys), then the Technology option, and Diff Pairs and New dialog are used to 
get to add differential pairs. The selected connections will be set up in the dialog 
ready to add. 

Improved DRC Checks for Diff Pairs 

The DRC option now checks the differential pair using the differential pair 
minimum gap (if defined in the Differential Pairs Technology dialog), even if 
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this gap is smaller than the spacing rules. DRC now applies this gap to all tracks 
in the diff pair path. Interactive track pairing will now always use the minimum 
gap. 

DRC now checks all the track making up the diff pair path for diff pair length 
even if they are not actually paired. Previously, only the ‘Diff paired’ tracks were 
checked. 

Options Changed in later V4.0 Patches 

These changes were made in V4.0 and are documented here for completeness. 

ODB++ Dialog Changes 

A new check box has been added Include Windows Plots. 

 
Click Use CAM/Plot Layer Combinations check box to output the layer 
definitions used in the CAM/Plot dialog. 
Click Include Windows Plots check box to output the Windows plots defined in 
the CAM/Plot dialog. If this is left unchecked, only plots defined for Gerber and 
Excellon are output as your layer combination when the above check box is 
selected. 
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Chapter 5. Spice Simulator Changes 

Simulation Update 

Changes to Edit Value (F7) dialog for Passives 

When editing Passive and Reactive devices using the F7 key (Edit Values), it 
now includes support for the E48, E96 and E192 series. 

 

Safe Operating Area (SOA) Testing 

In the later version 4.0 release, SOA Testing was introduced as a command 
driven feature only using the Extra Simulation Data dialog. In Version 4.5, 
Schematic changes have been made to provide an interface to the new Safe 
Operating Area (SOA) Limit Testing feature.  

A new SOA tab on Simulation Parameters dialog for enabling and configuring 
SOA testing has been added. 
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SOA Overview 

Safe Operating Area (SOA) testing is a feature that can be used with DC or 
Transient analyses. With SOA testing, you can set maximum and minimum 
limits for any simulation quantity and the simulator will display when those 
limits are violated. It is intended to check that semiconductor devices are 
operating within the manufacturer's design limits. 

New Built-In Simulator Parts ‘Watch’ Probe Functions added 

New simulator Parts with built-in functions have been added to support SOA 
testing: Watch - Current, Watch - Voltage and Watch - Differential Voltage. 
These are used to create Watch parts for simple SOA limit testing. 

These three new Parts have been added to the Spice Parts library. These are also 
available from the Insert Fixed Probes menu and on the Miscellaneous Parts 
popup toolbar. 
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Edit Device Parameters 

When editing Parts created with the SOA functionality, when using F7 key to 
edit the values, the generic Edit Device Parameters dialog is displayed for you 
to supply the Min and Max limits and a Label to mark any SOA violations. 

 

Full SOA Options Details 

 Option Name Default Description 
  value 

SOADERATING 1.0 Scales min and max values used in “.SETSOA” 
specification. This allows a de-rating policy to be 
globally applied to SOA limits. 

SOAMODE off Controls the Safe Operating Area (SOA) test mode. 
See “.SETSOA” below for details on how to define 
a SOA test. 

Can set to: 

Off  SOA testing is not enabled. In this mode 
.SETSOA controls will be read in and 
any errors reported, but no SOA testing 
will be performed during the run. 

Summary SOA testing enabled and results given in 
summary form with only the first 
violation for each expression given 
being output. 

Full  SOA testing enabled with full results 
given. Every violation will be reported 
in this mode. 

SOAOUTPUT list Can be:  

msg  Results displayed in command shell 
message window, or console if run in 
“non-GUI” mode 

list  Results output to list file 

msg|list  Results output to both list file and 
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command shell message window 

none  Results not output to either list file or 
message window. 

Note that all results are always stored for retrieval 
using the script function GetSOAResults described 
below. So even if “none” is specified the SOA data 
is always available. 

Setting up SOA limits within a model 

It is possible to define SOA limits within the .MODEL statement. To do this, add 
one or more parameters in the following format: 

LIMIT(name)=(min, max, xwindow) 

name  Name of quantity to test. See format for access variables 
useable when MODEL is specified for a .SETSOA control. 
This is described in section: “.SETSOA” in the section below. 
E.g. use ‘LIMIT(vcb)’ to specify the limits for the collector-
base voltage of a BJT. 

min, max  As described in “.SETSOA” below. 

xwindow  As described in “.SETSOA” below. 

Advanced SOA Limit Testing 

As well as the simple tests mentioned above, the simulator control .SETSOA 
allows much more sophisticated definitions for SOA limits. In particular, you 
can define limits for all devices belonging to a specified model. Suppose that you 
are using a BJT model that has a Vcb limit of 15V. While you could place a 
differential voltage watch device across each instance of this model, this would 
be time consuming and error prone. Instead, you can define a single .SETSOA 
control that refers to the model name of the device. The simulator will then 
automatically set up the limit test for every instance of that model. 

.SETSOA Definition 

.SETSOA [ LABEL=label ] [ MODEL=modelname | INST=instname ] 

[ ALLOWUNUSED ] [ ALLOWWILD ] 

expr1=( min1, max1[, xwindow1] ) 

[ expr2=( min2, max2[, xwindow2] ) ... ] 

Defines a Safe Operating Area (SOA) specification. If SOA testing is enabled 
the simulator will check simulated results against this specification and record 
any violations. 
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The results of SOA testing are output to the list file by default and can optionally 
also be displayed in the command shell message window, or console window if 
run in non-GUI mode. They are also always available via a script function 
GetSOAResults(). See .OPTIONS setting “SOAOUTPUT” for more details. 

label  Optional label that will be included in every violation report. 
You can use the following symbolic values in this label: 
%INST% - substituted with the instance name that violated the 
specification. This is only meaningful if MODEL or INST are 
specified. (See below). 
%MODEL% - substituted with the model name that violated 
the specification. Only meaningful if MODEL is specified. 
(See below). 
%EXPR% - substituted with the expression that violated the 
specification. 

instname  If specified the expression or expressions supplied in expr1 etc. 
are applied to the specified instance (e.g. Q23, M10, R56). In 
this case the expression may refer to node voltages and pin 
currents of the specified instance. See details under expr1, 
expr2... 

modelname  If specified the expression or expressions supplied in expr1 etc. 
are applied to every instance belonging to modelname. In this 
case the expression may refer to node voltages and pin currents 
for each instance processed. See details under expr1, expr2... 

expr1, expr2...  Expression to be evaluated and compared against minimum 
and maximum specs. This expression can access simulation 
results using access variables. The format and scope of these 
variables depends on whether MODEL, INST or neither is 
specified. 
If neither is specified, the expression can use the global access 
variables defined below: 

Syntax   Function   Example  

nodename  Voltage on node  VOUT – voltage on node VOUT 

n(nodename)  Voltage on node  n(VOUT) - voltage on node VOUT 

instname#param  Instance parameter  M2#vdsat – vdsat value for M2 

Q23#c – current in collector of Q23 

paramname  Parameter defined  
using .PARAM 

If there is a clash between a paramname and nodename, that is if the same name 
could refer to either a node or a parameter, then the parameter name takes 
precedence. To access the node in this case, use the n(nodename) syntax. 

Use the following values if MODEL or INST is specified. In each case 
(excepting the global access variable) the variable accesses a quantity for the 
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instance being processed. With INST this will be the single instance specified by 
instname. With MODEL all instance belonging to the model specified by 
modelname will be processed.  

Syntax  Function  Example 

pinname Current in pin c - current in collector of transistor 

Ipinname Current in pin Ic - current in collector of transistor 

Vpinname Voltage on pin Vc - voltage on collector of transistor 

n(pinname) Voltage on pin n(c) - voltage on collector of 
transistor 

 

Vxy  
Where x = 
pin name 1, 
y= pin name 
2. Both x and 
y must be 
single letters 

Voltage between x 
and y. 

Vbc – voltage from base to collector 

 

pow Power in device 

 

 

param Readback parameter vdsat - ‘vdsat’ for MOSFET 

 

#global_name Global node voltage 
or pin current 

#VOUT – voltage on net called 
VOUT 

#q23#c – current in collector of q23 

paramname Parameter defined 
using .PARAM 

 

Note that currently the use of V() and I() is not accepted and will result in an 
error message being displayed. 

min, max  Minimum and maximum values respectively. A violation 
message will be produced if the value of the associated 
expression is less than min or greater than max. Use ‘*’ if the 
limit is to be ignored. E.g. (*, 15) will test a maximum value of 
15 but the minimum value will not be tested. min and max 
values may be scaled using the SCADERATING .OPTIONS 
setting (see below for details). Currently, only constant values 
are accepted for min and max. Expressions are not permitted. 

xwindow  Optional value specifies a minimum window that must be 
surpassed before limit violations are registered. For example if 
10u is specified for xwindow for a transient analysis, then the 
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limit must be exceeded continuously for at least 10uS before 
the violation is recorded. 

ALLOWUNUSED If INST or MODEL are specified, an error will result if no 
instances to be processed are found. If INST is specified the 
error will occur if instname doesn’t exist. If MODEL is 
specified, the error will occur if there are no instances using 
modelname even if modelname itself is valid. 

This error will be inhibited if ALLOWUNUSED is specified 

ALLOWWILD  If specified, wildcards can be used for modelname and 
instname. In this case Pulsonix Spice will search for all devices 
that match the wildcard specification. Use ‘*’ to match any 
sequence of characters and ‘?’ to match a single character. 

New SOA Testing Script 

GetSoaResults 

No arguments 

Return type: string 

Returns the SOA results for the most recent simulation.  

Return Value 

Returns an array of strings, each one describing a single SOA failure. Each string 
is a semi-colon delimited list with fields defined below. 

Field  Description 

0  SOA Label 

1   Start of failure 

2  End of failure 

3 under’ or ‘over’. Defines whether the test fell below a 
minimum limit or exceeded a maximum limit. 

4  Value of limit that was violated 
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New Simulator Control Part 

A new generic Part called Simulator Control has been added to enable you to 
add control statements to the schematic rather than placing them in the Extra 
Simulation Data dialog. This way simulation parameters, like .param f0 1K for 
example, can be seen in the schematic design. The control statements will be 
added to the netlist when simulation is run. 

The new Simulator Control Part is also on the Miscellaneous popup toolbar. It 
uses a new Simulator Control spice function. 

 
When this Part is edited using the F7 key the Define Simulator Control dialog 
will be presented for you to enter one or more control statements. 

 

Simulator Bug Fixes 

Below is a list of Simulation fixes that you may need to be aware of: 

 Big "F" was not being stripped from Spice Value in the netlist when 
using it in a template.  

 Template now uses <SpiceValue> instead of %%<Spice Value>%%.  
This way the value is not substituted before the "F" is stripped off. Old 
templates will still work but will not strip off the F. 

 From a Simulation Graph window, the Plot menu option Create Plot 
Journal now works. It used to say this feature was not available. 

 Probing nets that start with + or a number now work correctly. 

 Now gives warning if you try to plot the ground node. 

 Now expands attribute values for <SpiceValue> and <SpiceParameters> 
when writing the netlist, so you can include values from other attributes 
using the %%attribName%% format. 
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Appendix A.  Supplementary File Changes 

This section details new default files and changes made to existing files. 

Format Files 

New format file examples are supplied to support the availability of the Report 
Maker in the Library Manager. 

 Part Details A new Part specific report to output Part 
details. 

 Part Gates (CSV) A new Part specific report to list gates 
used on a Part. File written in CSV 
format. 

 Parts Pins (CSV) A new Part specific report to list PCB 
footprint pins on a Part. File written in 
CSV format. 

 Library Contents A new report to list any Symbols or 
Footprints in a library. 

 Symbol Pad Report A new report to list information about 
pads within the symbol. 

 PCB Specification Sheet A new report provided as an example to 
generate an HTML format file that can 
be read in a HTML browser such as 
Explorer. 

Updated Libraries 

New Package Libraries 

New package libraries to support the 3D Viewer option are supplied. These are 
installed into the \MasterLibrary folder. 

 Connector.pkg New package library for connectors 

 SMT.pkg New package library for surface mounted 
components 

 Default.pkg New package library for all other devices 
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